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1.  

1.1 Symbole in der Betriebsanleitung 

 

ACHTUNG! 
Beachten Sie die Betriebsanleitung 

 

ACHTUNG! Gefahr von elektrischen Schlägen 

 

Doppelt Isoliert 

 

 
Anwendung in der Nähe und Demontage von gefährlichen Strom führenden Leitern ist 
erlaubt  
 

 

 
Erde 
 

 

 
AC (Wechselspannung) 
 

 

 
DC (Gleichspannung) 
 

 

 
Gleich- und Wechselspannung 
 

 

 
Stimmt mit den europäischen Richtlinien überein 
 

 

Werfen Sie das Multimeter nicht in den Hausmüll. Zur Entsorgung kontaktieren Sie einen 
qualifizierten Recyclingbetrieb. 

 
 

EN 61010-2-032 
CAT III 600V 
Immisions Grad 2 

1.2 Überspannungskategorien 

CAT I: Geräte, die an Stromkreise angeschlossen werden, in denen Vorkehrungen getroffen wurden, 
um transiente Überspannungen auf einen niedrigen Pegel zu begrenzen. 
CAT II: Einphasige Lasten, die mit der Steckdose verbunden sind darunter zählen Hausgeräte, por-
table Werkzeuge und ähnliche Lasten. 
CAT III: Drei-Phasen-Verteilung, einschließlich einphasiger kommerzieller Beleuchtung dazu zählen 
Geräte in Festinstallationen, z.B. Schaltgeräte und mehrphasige Motoren. 
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1.3 Sicherheitsinformationen 

Lesen Sie diese Sicherheitsinformationen vor der Benutzung des Netzanalysators gründlich und fol-
gen Sie den Anweisungen um einen sicheren Gebrauch zu gewährleisten. 

 Benutzen Sie den Analysator niemals für Spannungen >600V 

 Greifen Sie nicht über den oberen Rand der Klemme 

 Benutzen Sie die Klemme oder Zubehör nicht wenn es beschädigt ist. 

 Arbeiten Sie vorsichtig an hohen Spannungen 

 Arbeiten Sie vorsichtig bei Messungen >30VAC RMS oder bei Messungen >60VDC 

 Arbeiten Sie mit äußerster Vorsicht an offenen Leitungen und Stromschienen 

 Benutzen Sie das Messegerät immer nur so wie in der Betriebsanleitung beschrieben 
 
ACHTUNG: Falls Sie die Messleitungen nicht wie vom Hersteller beschrieben benutzen ist die Sicher-
heit beim Messen nicht mehr gewährleistet. 
 

2.  
 Leistungsanalyse in einem Einzel und Symmetrischen 3 Phasen System 

 Analyse von Strom und Spannung  

 True RMS Messung von Spannung mit einer Genauigkeit von 0,5% 

 True RMS Messung von Strom mit einer Genauigkeit von 1% 

 Grafische Darstellung von Strom und Spannung in einem Graphen 

 Grafisches Zeigerdiagramm 

 Erkennung und Speicherung von Ein-, Aus- und Zwischenschwingungen 

 Wirk- (W,KW,PS), Blind-(VAR,KVAR) und Scheinleistungen (VA, KVA) 

 Leistungsfaktor (cos φ), Phasenverschiebung (φ) und Energie (Arbeit)(Wh, kWh, KVARh)  

 Messung der symmetrischen 3 φ Leistungsqualität 

 Programmierbares V/t Verhältnis von 1 bis 3000 

 Hold Funktion 

 Automatische Abschaltung nach 15 Minuten (Auswählbar) 

 Datenspeicherung und Download auf den Computer 

 Optische Verbindung zwischen Messgerät und USB Kabel 

 Unbegrenzte Möglichkeit zur Speicherung von Messdaten auf dem Computer 
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3.  

 
1. Zangenvorrichtung 
2. Hebel zum Öffnen der Stromzange 
3. HOLD / CANCEL / Backlight – Mit dieser Taste können die das Display einfrieren oder die 

Hintergrundbeleuchtung ein- und ausschalten. Außerdem kann die Taste dazu verwendet 
werden die Ober- und Unterwellen zu löschen. 

4. Wahlschalter – Verwenden Sie den Wahlschalter um die Messmethode zu wählen 
5. LCD – Punktmatrix Display mit Hintergrundbeleuchtung 
6. + ► Knopf – Wert um 1 erhöhen / Referenzachse nach Oben verschieben / Liniencursor nach 

rechts verschieben / eine Seite weiter zum nächsten Ereignis 
7. REC – Drücken Sie diesen Knopf um die Datenaufzeichnung zu starten. Ein erneutes drücken 

stoppt die Aufnahme. Halten Sie den Knopf gedrückt und schalten Sie das Gerät ein um sämt-
liche Daten zu löschen. Außerdem können Sie hiermit weitere Wellen in der Konfiguration hin-
zufügen 

8. - ◄ Knopf – Wert um 1 verringern / Referenzachse nach unten verschieben / Liniencursor 
nach links verschieben / eine Seite zurück zum vorherigen Event 

9. FUNC Knopf – Drücken Sie diesen Knopf um eine andere Anzeige zu erhalten 
10. V-Eingangsbuchse – Eingangsbuchse für Spannung 
11. COM-Buchse – Masse oder Referenzeingang 
12. RS232-Fenster und Batteriefachdeckel   

600V

COM V L1L3
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4.  

4.1 Einstellungen 

Drehen Sie den Wahlschalter in die SETUP-Position. Sie sollten vor der Messung die Einstellungen 
für die jeweilige Messung vornehmen. 
 

 

 

4.1.1 Einstellmöglichkeiten im SETUP 

CURRENT TIME: Einstellung der Aktuellen Uhrzeit für den 
internen Kalender (H:MM) 
SAMPLE: Einstellung für die Datenaufnahme in Sekunden 
START TIME: Einstellen der Uhrzeit zum Starten der Daten-
aufzeichnung (H:MM) 
STOP TIME: Einstellen der Uhrzeit zum Stoppen der Daten-
aufzeichnung (H:MM) 
VT: Einstellen des Messwandlungsverhältnisses (Standard: 1) 
V(gelesen) = Spannung*VT 
MD: Der MD (Maximum Demand) Zeitbereich liegt zwischen 1 
und 60 Minuten. Wenn das Zeitintervall eingestellt wurde, be-

rechnet das Gerät die maximale Leistungsaufnahme und die durchschnittliche Leistungsaufnahme in 
Watt (W) oder VA 
HZ: Einstellen der Netzfrequenz (50Hz, 60Hz oder Auto) 
AUTO POWER OFF: Automatische Abschaltung EIN (1) oder AUS (0) 
TRANS REF: Einstellen der nominellen Spannung und der Schwelle(%) zur Schwingungsaufnahme 
  

Parameter auswählen 

Werte erhöhen oder 
verringern 
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HARMONICS CONFIG: Stellt ein welche Ober- und Unterwel-
len aufgenommen werden sollen. 
 
 
 
 
 
 
 
 
 

 
 
Hinweis: Das Messgerät passt die Wiederholungszeit entsprechend der Anzahl der eingestellten 
Schwingungen an. 

 
 
WAVEFORM CONFIG: Stellt ein wie viele Punkte bei jedem 
Durchgang der Schwingungsanzeige aufgenommen werden 
sollen. Vier Möglichkeiten sind einstellbar: 32, 64, 128, 256. 
 
Hinweis: Das Messgerät passt die Wiederholungszeit entspre-
chend der Anzahl der eingestellten Schwingungen an. 
  

Wellen löschen 

Wellen hinzufügen 

Wellen auswählen 
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DATE: Möglichkeit zur Einstellung des aktuellen Datums für den 
internen Kalender.  
Format: JJ:MM:TT 
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4.2 Messung des RMS Wertes, THD-F und Ober-/Unterwellen von Wechselspannung 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.2.1 Spannungsmessung 

a. Stellen Sie den Wahlschalter in die „V“ – Position 
b. Verbinden Sie die Messleitungen mit den entsprechenden Buchsen am Messgerät (siehe Bild) 
c. Halten Sie die Prüfspitzen parallel an die Kontakte, welche Sie messen möchten. 

 
Hinweis: Wenn die Spitzenspannung, der zu messenden Spannung, den Messbereich den Messgerä-
tes überschreitet erscheint im Display „OL“. 
  

L3 L1VCOM

600V
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% THD-F: Absolute Verzerrung der Oberwellen 
unter Berücksichtigung der Grundfrequenz. 
 
 

 

 
 
 
 

 
V1: Wert bei Nominalfrquenz (50Hz / 60Hz) 
V2: Wert bei 2. Schwingung 
... 
V50: Wert bei 50. Schwingung 
 
 
 
 
 
 
 
  

RMS Wert 

Schwingung 

Liniencursor 
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Hinweis: Die Frequenz wird auf der zweiten Seite angezeigt(Schwingungen von 25 bis 50) 
  

Cursor bewegen 
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4.3 Messung des RMS Wertes, THD-F und Ober-/Unterwellen von Wechselstrom 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.3.1 Strommessung 

a. Stellen Sie den Wahlschalter in die „A“- Position 
b. Klemme Sie die Zange wie abgebildet um den Leiter. Achten Sie hierbei auf die Stromfluss-

richtung. 
c. Der Messwert wird anschließend im Display angezeigt. 
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 % THD-F: Absolute Verzerrung der Oberwellen 
unter Berücksichtigung der Grundfrequenz. 
 
 

 

 
 
 

 
V1: Wert bei Nominalfrquenz (50Hz / 60Hz) 
V2: Wert bei 2. Schwingung 
... 
V50: Wert bei 50. Schwingung 
 

 
 
 
 
 
 
 
 
 
 
 

  

RMS Wert 

Schwingung 

Liniencursor 
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Hinweis: Die Frequenz wird auf der zweiten Seite angezeigt(Schwingungen von 25 bis 50) 
  

Cursor bewegen 
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4.4 Darstellung von ACV und ACA mit Phasenwinkel im Liniendiagramm 

4.4.1 Darstellung von Strom und Spannung mit Phasenwinkel 

Wenn Sie sich ACV und ACA im Diagramm anschauen möchten ist es notwendig, dass Sie die Zange 
um den Leiter legen (Strommessung) und die Messleitungen parallel an die Kontakt halten (Span-
nungsmessung). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Wenn Sie den Wahlschalter in die Position zur Anzeige des Dia-
gramms stellen zeigt das Messgerät die Spannung, den Strom 
und den Phasenwinkel an. 
 
 
 
 
 
 
 

Wenn Sie die Tasten +►oder -◄ drücken können Sie den Ref-

ferenzachse für die Spannung nach oben oder unten verschie-
ben.  
So können Sie wie im nebenstehenden Bild Strom und Span-
nung einfacher ablesen. 
  

Anzeige auswählen 
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4.4.2 Darstellung von Spannung (ACV) 

 
 
 
 
 
Drücken Sie die FUNC- Taste um die Darstellung von Spannung 
mit RMS-Wert und Spitzenwert anzuzeigen. 
 
 
 
 

4.4.3 Darstellung von Strom (ACA) 

 
 
 
 
 
Drücken Sie die FUNC- Taste um die Darstellung von Strom mit 
RMS-Wert und Spitzenwert anzuzeigen. 
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4.5 Einphasen Leistungsanalyse 

 
a. Stellen Sie den Wahlschalter in die Position „1 Phase“ 
b. Verbinden Sie die Messleitungen parallel zum Verbraucher  
c. Klemmen Sie die Zange um den Leiter, der zum Verbraucher führt. Achten Sie hierbei auf die 

Stromflussrichtung 
 
Hinweis: Wenn der Spitzenwert für Spannung oder Strom den Messbereich überschreitet zeigt das 
Messgerät OL an. 
 
Hinweis: Wenn das VT-Verhältnis nicht 1 ist dann ist der angezeigt Wert gleich dem gemessenen 
Wert (W, VA, VAR) multipliziert mit VT. 
Bsp.: WLCD = Wmess  * VT 

4.5.1 Messung von Leistung (W) und Leistungsfaktor (PF) 

        

4.5.2 Messung von Scheinleistung (VA, KVA) und Blindleistung (VAR, KVAR) 

 
  

-- ++

--

+

L3

L1
V

COM
600V
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4.5.3 Messung der abgenommenen Leistung (kW, kVA) 

 
 
Achtung: Sie müssen für diese Messung die automatische Abschaltung deaktivieren! 

4.5.4 Messung von Energie (KWh, PFh, KVARh und KVAh) 

 
 
Achtung: Sie müssen für diese Messung die automatische Abschaltung deaktivieren! 

4.5.5 Anzeige als Zeigerdiagramm 

 

4.5.6 Anzeige der RMS-Werte von Strom und Spannung 
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4.6 Messung eine symmetrischen 3 Phasen Netzes 

 
a. Stellen den Wahlschalter in die Position „3 Phase“ 
b. Verbinden Sie die Testleitungen parallel zur Spannungsquellen zwischen L1 und L3 
c. Klemmen Sie die Zange um den Leiter, der zum Verbraucher führt. Achten Sie hierbei auf die 

Stromflussrichtung 
d. Drücken Sie die FUNC Taste um folgende Anzeigen zu erhalten 

4.6.1 Messung von Leistung (W) und Leistungsfaktor (PF) 

        

4.6.2 Messung von Scheinleistung (VA, KVA) und Blindleistung (VAR, KVAR) 

 
  

L1

L3

L1

L2

L3+

600V
COM

V L1

L3
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4.6.3 Messung der maximalen Leistung (kW, kVA) 

 
 
Achtung: Sie müssen für diese Messung die automatische Abschaltung deaktivieren! 

4.6.4 Messung von Energie (Arbeit) (KWh, PFh, KVARh und KVAh) 

 
 
Achtung: Sie müssen für diese Messung die automatische Abschaltung deaktivieren! 

4.6.5 Anzeige als Zeigerdiagramm 

 

4.6.6 Anzeige der RMS-Werte von Strom und Spannung 
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5. - -
 

5.1 Geplante Aufzeichnung 

a. Stellen Sie den Wahlschalter in die „V“ Position 

 
b. Wenn Sie folgendes Bild auf dem Display sehen drücken Sie die REC Taste und es startet die 

Datenaufzeichnung mit der im Setup eingestellten Wiederholungsrate.  

Hinweis: Der erste RMS-Wert und die erste Schwingung werden immer aufgezeichnet. 
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c. Wenn Sie die REC Taste gedrückt haben erscheint folgende Anzeige 

 
Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste für 
2 Sekunden lang halten. 
Wenn die HOLD Taste nicht gedrückt wird, wird die Aufzeichnung gestartet. Wenn die Daten-
aufzeichnung gestartet wurde blinkt die Led neben den Anschlussbuchsen. 
 
Die Start- und Stoppzeit stellen Sie im SETUP ein. 

5.2 Sofortige Datenaufzeichnung 

Drücken Sie die REC Taste zweimal. 
Die Startzeit wird automatisch für die folgende Minute festgelegt. 
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag. 
 

6. – -
 

6.1 Geplante Aufzeichnung 

a) Stellen Sie im SETUP eine Start- und Stoppzeit ein. Stellen Sie den Wahlschalter in die „A“ 
Position 
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b) Um die Aufzeichnung zu starten drücken sie die REC Taste 

 
c) Sobald die REC Taste gedrückt wurde erscheint folgende Anzeige im Display 

 
Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste für 
2 Sekunden lang halten. 
Wenn die HOLD Taste nicht gedrückt wird, wird die Aufzeichnung gestartet. Wenn die Daten-
aufzeichnung gestartet wurde blinkt die Led neben den Anschlussbuchsen 

6.2 Sofortige Datenaufzeichnung 

Drücken Sie die REC Taste zweimal. 
Die Startzeit wird automatisch für die folgende Minute festgelegt. 
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag. 
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7. -
 

7.1 Aufzeichnung der Kennlinie von Strom und Spannung 

Setzen Sie den Wahlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Drü-
cken Sie die FUNC Taste bis im Display die Wellen für Strom und Spannung zu sehen sind. 
Drücken Sie die REC Taste um die Datenaufzeichnung zu starten. Nun werden Strom und Spannung 
aufgezeichnet. 

 
 
Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen können sie im SETUP einstellen. 
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7.2 Aufzeichnung der Spannungskennlinie 

Setzen Sie den Wahlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Drü-
cken Sie die FUNC Taste bis im Display die Welle Spannung zu sehen ist. 
Drücken Sie die REC Taste um die Datenaufzeichnung zu starten. 
 

 
 
Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen können sie im SETUP einstellen. 
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7.3 Aufzeichnung der Stromkennlinie 

Setzen Sie den Wahlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Drü-
cken Sie die FUNC Taste bis im Display die Welle Spannung zu sehen ist. 
Drücken Sie die REC Taste um die Datenaufzeichnung zu starten. 
 

 
 
Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen können sie im SETUP einstellen. 
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8.  
Stellen Sie den Wahlschalter in die Position „Transient“. Auf dem Display wird Ihnen folgendes ange-
zeigt: 

 
 
Es wird Ihnen die Referenzspannung (TRANS REF) von 110V mit einem Schwellwert von 5% ange-
zeigt. 
Wenn die Spannung 115,5V (SWELL) überschreitet oder die Spannung kleiner als 104,5V (DIP) ist 
oder kleiner als 40V (OUTAGE) dann wird eine Störung aufgezeichnet. 
 
Hinweis: Sie können maximal 32000 aufzeichnen. 
 
Drücken Sie die FUNC Taste um die Erkennung von Störschwankungen zu starten. 
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Nachdem Sie die FUNC Taste gedrückt haben wird die Anzeige geleert und die LED neben den An-
schlussbuchsen fängt an zu blinken. 
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Um die Aufzeichnung zu stoppen betätigen Sie erneut die FUNC Taste. Mit Hilfe der +►oder -◄ ist es 

Möglich zwischen den einzelnen Aufzeichnungen hin und her zuschalten. 
 

 
 
 
  

Stop und Ansicht 

Vor und zurück 
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Aufzeichnungsnummer 

Spannung niedrig 

Spannung hoch 

Startzeit 

Dauer 

Spannung hoch 

Spannung < 40V 

Aufzeichnungsnummer Startzeit 

Dauer Spannung niedrig 



 BETRIEBSANLEITUNG  
_____________________________________________________________________________________________________ 

www.warensortiment.de 

 

32 

9.  

9.1 Geplante Aufzeichnung 

Stellen Sie den Wahlschalter in die 3 PHASE Position. Drücken Sie die REC Taste einmal um die 
Aufzeichnung zu starten.  
Stellen Sie vorher die Start- und Stoppzeit im SETUP ein. 
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Wenn die REC Taste gedrückt wurde erscheint folgende Anzeige. 

 
 

Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste für 2 Se-
kunden lang halten. 
Wenn die HOLD Taste nicht gedrückt wird, wird die Aufzeichnung gestartet. Wenn die Datenaufzeich-
nung gestartet wurde blinkt die Led neben den Anschlussbuchsen. 
 

 
 
Das Messgerät zeichnet 50.000 Werte (Datum/Zeit, VA, W, VAR, PF, KVAH, KWH, KVARH, PFH,  
AD(VA), AD(W), MD(VA), MD(W), Phase, PS) auf. 
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9.2 Sofortige Datenaufzeichnung 

Drücken Sie die REC Taste zweimal. 
Die Startzeit wird automatisch für die folgende Minute festgelegt. 
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag. 

10.  
Um den Speicher des Datenloggers zu löschen halten Sie die REC Taste und schalten Sie das Gerät 
ein. Drücken Sie die HOLD Taste um das Löschen des Speichers zu bestätigen. 
Wenn der interne Speicher komplett gelöscht wurde, schaltet sich das Gerät automatisch ab. 

 
 
Wenn Sie die HOLD Taste nicht für 8 Sekunden gedrückt halten, wird der Speicher nicht geleert. Dies 
verhindert, dass der Speicher unabsichtlich gelöscht wird. 

11.  
Baud Rate: 9600 
Daten Bits: 8 
Stopp Bits: 1 
Parität: Keine 
Format: ASCII 

12.  

12.1 Leistung  

Leistung (50 oder 60 Hz, PF 0.5 bis 1.0, VT = 1, Spannung > 5V AC, Strom > 5A AC im A Be-
reich, und kontinuierliche Schwingung) 

Bereich (0 bis 
1500A) 

Auflösung Genauigkeit der Messung
1
 

> 20 V und > 
20A 

< 20V oder < 
20A 

10.0 – 999.9 W 0.1W ±1% ±20dgts ±2% ±40dgts 

1.000 – 9.999 KW 0.001 KW ±1% ±20dgts ±2% ±40dgts 

10.00 – 99.99 KW 0.01 KW ±1% ±20dgts ±2% ±40dgts 

100.0 – 999.9 KW 0.1 KW ±1% ±20dgts ±2% ±40dgts 

1000 – 9999 KW 1 KW ±1% ±20dgts ±2% ±40dgts 
 

1
Bei VT ≠1, ist die Auflösung in Prozent dieselbe (±1%). Die zusätzliche Angabe der Leistung muss 

mit VT multipliziert werden 
Beispiel: ±0.2W wird ±0.2W * VT  
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12.2 Scheinleistung  

Scheinleistung (VA, von 0.000VA bis 9999 KVA, PF 0.5 bis 1) 

Bereich (0 bis 
1500A) 

Auflösung Genauigkeit der Messung
1
 

> 20 V und > 
20A 

< 20V oder < 
20A 

10.0 – 999.9 VA 0.1VA ±1% ±20dgts ±2% ±40dgts 

1.000 – 9.999 KVA 0.001 KVA ±1% ±20dgts ±2% ±40dgts 

10.00 – 99.99 KVA 0.01 KVA ±1% ±20dgts ±2% ±40dgts 

100.0 – 999.9 KVA 0.1 KVA ±1% ±20dgts ±2% ±40dgts 

1000 – 9999 KVA 1 KVA ±1% ±20dgts ±2% ±40dgts 
1
Bei VT ≠1, ist die Auflösung in Prozent dieselbe (±1%). Die zusätzliche Angabe der Leistung muss 

mit VT multipliziert werden 
Beispiel: ±0.2VA wird ±0.2VA * VT  

12.3 Blindleistung  

Blindleistung (VAR, von 0.000 VAR bis 9999 KVAR) 

Bereich (0 bis 
1500A) 

Auflösung Genauigkeit der Messung
1
 

> 20 V und > 
20A 

< 20V oder < 
20A 

10.0 – 999.9 VAR 0.1VAR ±2% ±30dgts ±3% ±40dgts 

1.000 – 9.999 
KVAR 

0.001 
KVAR 

±2% ±30dgts ±3% ±40dgts 

10.00 – 99.99 
KVAR 

0.01 KVAR ±2% ±30dgts ±3% ±40dgts 

100.0 – 999.9 
KVAR 

0.1 KVAR ±2% ±30dgts ±3% ±40dgts 

1000 – 9999 KVAR 1 KVAR ±2% ±30dgts ±3% ±40dgts 
1
Bei VT ≠1, ist die Auflösung in Prozent dieselbe (±1%). Die zusätzliche Angabe der Leistung muss 

mit VT multipliziert werden 
Beispiel: ±0.2VAR wird ±0.2VAR * VT  
 
Bereich von VT (Volt Transformer) Ratio: 1 bis 3000 
 
Energie (Arbeit) (WH, oder KWH, von 0 WH bis 999.999 kWH) 
Berechnung: WH = W * Time (in Stunden) 

12.4 Strom 

Strom (50 oder 60 Hz, Auto Range, True RMS, Spitzenfaktor < 4, Überlastschutz 2000A) 

Bereich Auflösung Genauigkeit der Messung 

4.0 – 1500.0 A 0.01 A ±1.0% ± 5dgts 

12.5 Spannung 

Spannung (50 oder 60 Hz, Auto Range, True RMS, Spitzenfaktor < 4, VT=1, Input Impedanz 10 MΩ, 
Überlastschutz 800V) 

Bereich Auflösung Genauigkeit der Messung
1
 

4.0 V – 600.0 V 0.1 V ±0.5% ± 5dgts 
1
Bei VT ≠1, ist die Auflösung in Prozent dieselbe (±1%). Die zusätzliche Angabe der Digits muss mit 

VT multipliziert werden 
Beispiel: ±0.2dgts wird ±0.2dgts * VT  
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12.6 Oberwellen in der Spannung in Prozent 

Oberwellen in der Spannung in Prozent (1 bis 50 Ordnung, Minimal Spannung bei 50 Hz oder 60 Hz 
> AC 80V. Wenn die Spannung bei 50Hz 0V beträgt, wird 0 Prozent angezeigt. 

Bereich Auflösung Genauigkeit 

1 – 20
th
 0.1% ±2% 

21 – 50
th
 0.1% 4% des gelesenen ±2.0% 

 

12.7 Oberwellen in der Spannung als absoluter Wert 

Oberwellen in der Spannung als absoluter Wert (1 bis 50 Ordnung, Minimal Spannung bei 50 Hz 
oder  60 Hz  > 80V, VT=1) 

Bereich Auflösung Genauigkeit 

1 – 20
th
 0.1% ±2% ± 0.5V 

21 – 50
th
 0.1% 4% des gelesenen ±0,5V 

 

12.8 Oberwellen im Strom in Prozent 

Oberwellen im Strom in Prozent (1 bis 50 Ordnung, Minimal Strom bei 50 oder 60 Hz > 20 A. Wenn 
der Strom bei 50Hz 0A beträgt, wird 0 Prozent angezeigt 

Bereich Auflösung Genauigkeit 

1 – 20
th
 0.1% ±2% 

21 – 50
th
 0.1% 4% des gelesenen ±2.0% 

 

12.9 Oberwellen im Strom als absoluter Wert 

Oberwellen im Strom als absoluter Wert (1 bis 50 Ordnung, Minimal Strom bei 50 oder 60 Hz > 20A) 

Bereich Auflösung Genauigkeit 

1 – 20
th
 0.1% ±2% des gelesenen ±0.4A 

21 – 50
th
 0.1% ±4% des gelesenen ±0.4A 

 

12.10 Leistungsfaktor 

Leistungsfaktor (PF) 

Bereich Auflösung Genauigkeit 

  > 20V und > 20A < 20V oder < 
20A 

0.000 – 1.000 0.001 ± 0.04 ±0.1 

 

12.11 Phasenwinkel 

Phasenwinkel (Φ) 

Bereich Auflösung Genauigkeit 

-180° - 180° 0.1° ± 1° 

0° - 360° 0.1° ± 1° 
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12.12 Schwingungsstörungen 

Schwingungsstörungen (THD-F unter Beachtung von 50 oder 60 Hz, min. Wert bei 50 oder 60 Hz > 
80V und > 20 A, 1 bis 50

th 
Schwingung. Wenn der Strom oder die Spannung bei 50Hz oder 60Hz 0 ist 

werden 0% angezeigt. 

Bereich Auflösung Genauigkeit 

0.0 – 20% 0.1% ± 2% 

20.1 – 100% 0.1% ± 6% des gelesenen ± 1% 

100.1 – 999.9 % 0.1% ± 10% des gelesenen ± 1% 

 

12.13 Wert der Spitzenwerte von Strom und Spannung  

Wert der Spitzenspannung (Spitzenwert > 10V) oder Spitzenstrom (Spitzenwert > 20A) 

Bereich Auflösung Genauigkeit 

50 Hz 39 μs ± 5% ± 50 Digits 

60 Hz 33 μs ± 5% ± 50 Digits 

 
 Frequenz (RMS Wert > 20V) oder ACA (RMS Wert > 30A)  

Bereich Auflösung Genauigkeit 

46 – 65 0.1 ± 0.3Hz 

 
Nur für den Gebrauch im Innenbereich! 
 
Leitergröße:  ca. Ø 55mm, 65 x 24mm (Stromschienen) 
Batterietyp:  2*AA 1.5V 
Display:  128 X 64 Matrix LCD mit Hintergrundbeleuchtung 
Messbereichsauswahl:  Automatisch 
Überlastanzeige:  OL 
Stromverbrauch:  ca. 10mA 
Automatische Abschaltung: 15 Min. nach dem Einschalten 
Update Zeit:  2 Wiederholungen/Sekunde (Display) 
Anzahl Messwiederholungen  512 (Spannung oder Strom) 
     256 (Leistung) 
Betriebstemperatur:  -10 C bis 50 C 

Maximale Luftfeuchtigkeit maximal 85% relativ 
Einsatzhöhe:  bis zu 2000 Meter 
Lagertemperatur:  -20 C bis 60 C 

Lagerluftfeuchtigkeit:  weniger als 75% relativ 
Abmessungen:  271mm (L) x 112mm (W) x 46mm (H) 
Gewicht:  647g inkl. Batterien 
Zubehör:  Messleitungen 
     Aufbewahrungstasche 
     Bedienungsanleitung 
     Software Bedienungsanleitung 
     Software 

 Batterien AA 1.5V x 2 
     Krokodilklemmen 
     RS232 – USB Adapter 
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13.  
Der Ladestand der Batterie wird im Display angezeigt 
 

 
 
Wenn Sie die Batterien wechseln möchten gehen sie wie folgt vor: 

a. Schalten Sie das Gerät aus und entfernen Sie die Messleitungen von dem Messgerät 
b. Lösen Sie die Schrauben an dem Batteriefachdeckel 
c. Entfernen Sie den Batteriefachdeckel 
d. Nehmen Sie die alten Batterien aus dem Fach 
e. Drücken Sie die FUNC Taste um Restspannungen aus dem Gerät zu lassen 
f. Setzen Sie die neuen Batterien ein 
g. Legen Sie den Deckel wieder auf und ziehen Sie die Schrauben fest 

14.  
Lösungsansätze und Reparaturen, die nicht in dieser Betriebsanleitung beschrieben sind dürfen nur 
von geschultem und qualifiziertem Fachpersonal durchgeführt werden. 
Reinigen Sie das Gehäuse des Messgerätes nur mit einem feuchten Tuch. Verwenden Sie keine 
Scheuer- oder Lösungsmittel 

  

 
Batterie OK 

 
Batterie leer 
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15.  

15.1 Betriebsvorraussetzungen 

 PC mit dem Betriebssystem Microsoft Windows Vista / XP / 2000(SP3) 

 NI-VISA Engine installiert (Wird automatisch bei der Software Installation installiert) 

 Passender USB-Treiber installiert (Kapitel 2) 

15.2 Hardwarevoraussetzungen 

 PC mit mindesten einem 600Mhz Prozessor 

 Min.: 256 MB RAM Empfohlen: 512MB oder mehr 

 Min. Bildschirmauflösung von 1024*768 Pixeln 

15.3 Vorgehensweise beim Anschließen 

1) Schalten Sie das Messgerät und den PC ein 
2) Verbinden Sie das Messgerät via USB-Kabel mit dem Computer 
3) Starten Sie das Programm des Netzanalysegerätes 
4) Wählen Sie den Seriellen Port aus, an dem das Gerät angeschlossen ist. 

16.  

16.1 Programminstallation 

Starten Sie die setup.exe auf der mitgelieferten CD. Danach startet das Installationsprogramm selbst-
ständig. Folgen Sie den Anweisungen auf dem Bildschirm. 
 
Hinweis:  

 Nachdem Sie die CD in Ihr CD-ROM Laufwerk gelegt haben startet die CD automatisch 

 Wenn das Programm erfolgreich installiert wurde starten Sie den Computer neu 

16.2 USB-Treiberinstallation 

Öffnen Sie CD im Arbeitsplatz und starten Sie CP210x_VCP_Win2K_XP_S2K3.exe um die Installation 

des USB-Treibers zu starten. 

 

Hinweis: 

 Falls die Hardware nicht erkannt wurde, entfernen Sie den Stecker aus dem USB-Port und 
versuchen Sie es erneut 
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17.  

17.1 Starten des Programms 

Gehen Sie auf Start -> Programme -> CLAMP-ON Graphic Power Quality Analyzer um das Programm 

zu starten. 

Wählen Sie den Port aus an dem das Gerät angeschlossen ist und klicken Sie anschließend auf  
 
Wenn Sie nicht genau wissen welcher Port dies ist, können Sie dies im Geräte Manager nachschau-
en. 

 

17.2 Funktionen im Hauptbildschirm 

Gehen Sie in den Hauptbildschirm von der Software. 
 

 
 

1) In der Werkzeugleiste finden Sie Funktionen wie Einstellungen, Kommunikation zwischen PC 
und Messgerät, Download von Daten vom Messgerät, Informationen und Beenden. 

2) System Nachrichten werden hier dargestellt. 

17.3 Einstellung der Parameter 

Klicken Sie in der Werkzeugleiste auf File -> Setup um in die Einstellungen zu gelangen. Nachdem 
Sie die Einstellungen im Programm vorgenommen haben werden diese in den Speicher des Messge-
rätes geschrieben. 

17.3.1 Zeit und Datum 

 

 
 

Klicken Sie auf  um Datum um Zeit einzustellen. Klicken Sie anschließend auf  um die 
Einstellungen zu übernehmen. 

2 

1 
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17.3.2 Datenloggereinstellungen 

Einstellmöglichkeiten von Messwiederholungen (Sample), Start- und Stoppzeit (Start Time / Stop Ti-
me) und die Anzahl der Punkte im Diagramm (Waveform point) 
 

 
 

17.3.3 Systemeinstellungen 

Einstellmöglichkeiten von Voltage Transformator (VT), Referenzspannung für Störspannungen 

(TRANS REF) und dessen Bereich (%), Frequenz (Hz), Demand Time (MD) und automatische Ab-

schaltung (Auto Power Off). 

 
  



 BETRIEBSANLEITUNG  
_____________________________________________________________________________________________________ 

www.warensortiment.de 

 

42 

17.4 Kommunikation 

Klicken Sie auf „Communication“ um in den Bildschirm für die Kommunikation zu gelangen. 

Um mit dem Gerät kommunizieren zu können müssen sie den Messbereich auf 3 Phase, 1 Phase, V, 

A, oder VA stellen. 

 

 

 

In der Werkzeugleiste können Sie auswählen, welche Funktion Sie benutzen wollen.  

Datei öffnen (Open), Messdaten speichern (Save), Datei schließen (Close), Demand Time und die 

Wiederholungsrate (MD Time & Sample Rate), Bildschirm drucken (Print), als Grafik anzeigen lassen 

(Waveform) und Beenden (Exit). 

 

Angezeigt wird Ihnen die aktuelle Uhrzeit (Current Time), Startzeit (Start Time), Voltage Transformator 

(VT), Frequenz (Hz), Demand Time (MD), Wiederholungsrate (Sample Rate), Anzahl der Aufgenom-

menen Daten (Sample Count) und welche Messdaten zur Zeit angezeigt werden (Present Sample). 
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17.5 Download von Daten 

Klicken Sie auf Datalogger -> Down Load Data (Strg+D) um Daten vom Messgerät zu laden. 
 

 
 
Es wird angezeigt wie viel Prozent schon vom Gerät herunter geladen wurde. 
Klicken Sie auf Reset um den Download abzubrechen.  

17.6 Speicher löschen 

Klicken Sie auf Datalogger -> Clear Memory (Strg+C) um in den Bildschirm zum Löschen der Daten 
zugelangen. 

 
 
Bestätigen Sie mit einem Klick auf „Clear Memory“ um den Speicher zu löschen. 
 
Achtung: Gelöschte Daten auf dem Messgerät können nicht wiederhergestellt werden! Wenn Sie die 
Daten benötigen, laden Sie diese vorher vom Gerät herunter und speichern Sie diese auf dem Com-
puter (Kapitel 4.5). 
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18.  
Die Software zeigt an, welche Daten aktuell auf dem Display des Messgerätes dargestellt werden. 
Wenn Sie die FUNC Taste drücken wird ausgewählt was angezeigt werden soll. 

18.1 Kommunikationsbildschirm 1 

Stellen Sie den Wahlschalter am Messgerät in die Stellung „3 Phase“ oder „1 Phase“ und klicken Sie 
anschließen auf „Communication“ um in den Kommunikationsbildschirm 1 zu gelangen. 
 

 
 

1) Anzeige von Scheinleistung (S), Wirkleistung (P) und Blindleistung (Q) 
2) Anzeige der Durchschnittsabnahme und der maximalen Abnahme 
3) Anzeige von Leistungsfaktor (PF), PFF, Phasenwinkel, Leistung in PS (HP) 

18.2 Kommunikationsbildschirm 2 

Stellen Sie den Wahlschalter am Messgerät in die Stellung „V“ und klicken Sie anschließen auf 
„Communication“ um in den Kommunikationsbildschirm 2 zu gelangen. 
 

 
 

1) Darstellung der Spannungskurve 
2) Darstellung des Amplitudenspektrums 
3) Darstellung der Schwingungen (Auswählbar) 
4) Anzeige der aktuellen Werte von RMS, Spitze (Peak) und THD 
5) Anzeige von Stärke und Prozentanteil 

  

1 

2 

3 

1 
3 

2 

4 

5 
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18.3 Kommunikationsbildschirm 3 

Stellen Sie den Wahlschalter am Messgerät in die Stellung „VA“ und klicken Sie anschließen auf 
„Communication“ um in den Kommunikationsbildschirm 3 zu gelangen. Nachdem Sie die Messung für 
Strom und Spannung durchgeführt haben erhalten Sie folgende Anzeige auf dem Bildschirm: 
 

 
 

 
1) Anzeige von der Spannungs- und Stromkennlinie. 
2) Anzeige der aktuellen Leistung (P), Scheinleistung (S) und Phase 

18.4 Kommunikationsbildschirm 4 

Stellen Sie den Wahlschalter am Messgerät in die Stellung „VA“ und klicken Sie anschließen auf 
„Communication“ um in den Kommunikationsbildschirm 4 zu gelangen. Nachdem Sie die Spannungs-
messung durchgeführt haben erhalten Sie folgende Anzeige auf dem Bildschirm: 
 

 
 

1) Anzeige der Spannungskennlinie 
2) Anzeige des aktuellen RMS- und Spitzen- (Peak) wertes 

  

1 

2 

1 

2 
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18.5 Öffnen und Speichern von Messdaten 

Sie können Daten von den Kommunikationsbildschirmen oder heruntergeladene Messdaten, vom 
Messgerät, speichern. 
Hierzu klicken Sie: File -> Save (Strg+S) die aktuellen Daten werden dann als .csv –Datei gespeichert 
 

 
 

18.6 Einstellen der MD Zeit und der Wiederholungsrate 

Klicken Sie auf File -> MD Time & Sample Rate und klicken Sie anschließen auf „Setting“. 
 

 
 

Danach erscheint folgendes Fenster: 
 

 
 

Sie haben nun die Möglichkeit die Parameter zu ändern. Klicken Sie auf Enter um die Einstellungen 
zu bestätigen. 
 
Achtung: Gespeicherte Daten gehen mit dem Bestätigen verloren. Speichern Sie die Daten bevor Sie 
MD Zeit und Wiederholungsrate ändern. 
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18.7 Auswählen des Druckers 

Klicken Sie File -> Print. Anschließend klicken Sie auf „▽” um den entsprechenden Drucker auszuwäh-

len.  

 
 

18.8 Schwingungsverlauf 

Klicken Sie im Kommunikationsbildschirm auf „Waveform“ und wählen Sie aus welchen Verlauf Sie 
angezeigt haben möchten. 
 

Kommunikationsbildschirm I : V, A, S, P, Q, PF, Phase, KVAH, KWH, 

KVARH, PFH, VA(AD), W(AD), 

VA(MD), W(MD) 

Kommunikationsbildschirm II : RMS, Peak, THD 

Kommunikationsbildschirm III : V, A, P, S, Phase 

Kommunikationsbildschirm IV : RMS, Peak 
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18.9 Schwingungsverlauf aktualisieren 

Sie können im „Waveform-Bildschirm“ manuell die Skala und die Cursorposition verändern um die 
Messwerte genauer betrachten zu können. Wenn Sie dies ausversehen gemacht haben können sie 
das wie folgt rückgängig machen um die komplette Schwingung zu betrachten. 

Klicken Sie File -> Redraw und der Graph wird erneut angezeigt. 

 

 
 

1) Wert der aktuellen Cursorposition 
2) Anzeige des ausgewählten Graphen 
3) Ändern der aktuellen Cursorposition 
4) Klicken Sie auf die Skala um den Bereich den Sie betrachten wollen zu verschieben 

18.10 Schwingungsverlauf drucken 

Klicken Sie auf File -> Print um den aktuell angezeigten Schwingungsverlauf auszudrucken. 

18.11 Betriebsarten 

Real Time Modus: Zeigt die aktuellen Daten im Kommunikationsbildschirm an 
History Modus: Zur Betrachtung von vorher aufgezeichneten Daten. Es werden weiterhin Daten ge-
speichert. 
File Modus: Öffnet gespeicherte Messdaten von dem Computer 
 

  

1 

2 

3 

4 
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18.12 Reset der Betriebsart 

Gehen Sie auf View -> Reset. Die Daten, die aktuell angezeigt werden, werden ausgeblendet und die 

Software geht in den Real Time Modus. 

 

 
 

1) Auswahl der Betriebsart und Reset der Betriebsart 
2) Auswahl der aktuell angezeigten Messwerte (nur im History Modus möglich) 

 
 
 
 
 
 
 
Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH. 
 
 
Eine Übersicht unserer Messtechnik finden Sie hier: http://www.warensortiment.de/messtechnik.htm 

Eine Übersicht unserer Messgeräte finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete.htm 

Eine Übersicht unserer Waagen finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete/waagen.htm 

 
 
 
Zur Umsetzung der ElektroG (Rücknahme und Entsorgung von Elektro- und Elektronikaltgeräten) nehmen wir 
unsere Geräte zurück. Sie werden entweder bei uns wiederverwertet oder über ein Recyclingunternehmen nach 
gesetzlicher Vorgabe entsorgt. 
 

WEEE-Reg.-Nr.DE69278128 
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